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Purpose 

• The purpose of this briefing is to provide guidance and instructions 
about how to create a briefing with PowerPoint. 

• This guidance applies to the creation of slides to be presented with 
electronic projection or desk-side as hard copy.   It also applies to 
the creation of slides for a hard copy document in scripted briefing 
format.    

• This guidance assumes the use of Microsoft Office 97 or 2000 
software.  If necessary, adapt to other software to achieve the intent 
of this guidance.

• Adherence to this guidance will enable your briefings to conform to 
the intent and standards of CG, TRADOC and Director, TRAC.

• More importantly, adherence to this guidance and instructions will 
promote the professional quality of your briefing.

Please send suggested changes to this briefing to Director, TRAC.
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General Guiding Principles

• Each slide should clearly convey an important message or piece of a larger 
message.  Woven together, a briefing of slides should tell a story. 

• Create each slide to stand on its own merit.  The notes pages or written 
script may be used to introduce additional relevant information and 
explanations.  An explanation given verbally may be lost or confused by 
others when the slide is further distributed.  

• Be concise.  Make the slide easy to read and understand at a glance. 

• Use embedded “pictures” and “images” sparingly and only when needed to 
support the slide message.  Reduce their file size using format conversion 
(process is described later).  

• Avoid “eyewash” (e.g., cartoon clip art, animation, showy slide transitions).

• Be consistent throughout the briefing.  Apply format, layout of contents, 
graphics, labels, colors, and terminology uniformly on the briefing slides.  
Consistency from slide-to-slide enables the audience to anticipate the 
information on the next slide, thereby aiding the flow of the briefing.

• However, don’t be a slave to a cookie-cutter approach.  If a format is 
imposed on one slide (e.g., line spacing to accommodate more text), it 
doesn’t have to apply exactly the same way to every slide.  The audience 
won’t notice subtle differences.  
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The First Slide
(aka Briefing Title Slide)

• The first slide will present the title of the briefing.  It will be horizontally 
centered above the TRAC crest, in a font size from 28 pt to 38 pt, bold.  If a 
second modifying line is used, it will be a smaller font, centered and italic.

• Additional information will be presented in the briefing subtitle horizontally 
centered below the TRAC crest, in a font size from 20 pt to 28 pt, bold.

• As a minimum, the briefing subtitle will identify the date of the briefing.  The 
meeting or location may be identified as well.

• Name(s) may be identified in the subtitle, either the briefer(s) or those being 
briefed.  To distinguish the briefing recipient from the briefer or briefing 
originator, add “Briefing to” or “Briefing for.”

• The only image on the first slide will be the TRAC crest.  There is only one 
standard TRAC crest.  The use of any other version is forbidden.  On the title 
slide, the crest will be 2.25” in diameter and perfectly centered.  (For further 
information about the TRAC crest, contact TRAC Operations.)

• The background of the first slide will be completely white (clear).  Do not use 
any other graphics, images, water marks, colors, etc., on the first slide.

• If the briefing is distributed as an officially published TRAC document, the 
briefing will also require a document number and a distribution statement.  
(This topic is addressed in separate guidance regarding TRAC publications.)
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Title of Follow-on Slides
and Subtitles of Follow-on Slides

• The slide title on this TRAC master (shown above this line) 
represents the standard for all slides that follow the first or 
intro slide: 

– 28 pt and Arial bold. 

– Centered with a 0.1” internal margin on the left and right.  (The 
TRAC master template is not set up to wrap this text.)

• Capitalize only the first letter of major words in titles.  Do not 
capitalize all letters in titles.   

• Type titles in the “text box” provided with the template.  Do 
not add a separate text box.  Using the existing text box 
allows you to change size or placement of all titles in the file 
at once, if necessary.  It also provides the label for the outline 
feature in PowerPoint.

• The text box is sized to permit a subtitle to be added as a 
second line in the title.  Use this option sparingly.  If used, the 
subtitle should be a font size of 18 pt to 24 pt, italicized.
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Text 

• All text will be Arial font.  Do not use shadows on text, letters, or numbers. 

• The preferred text font size is 20 pt to 24 pt for a briefing that is to be 
projected.  Minimum is 18 pt.  A smaller font size may be used sparingly 
only as an exception.  A slide for hard copy documentation (not intended 
for projection) may use a smaller font size than 18 pt; the minimum is 12 pt.

• The standard default line spacing for text will be 0.9 line space in all 
instances.  On an exception basis, line spacing may range from 0.85 to 0.95 
for best appearance.  Avoid using the full 1 or greater for line spacing. 

• Bullet types will be selected from those available in the “Normal Text” 
menu; go to the “Format” pull-down menu, and select “Bullet.” 

• Preferred bullet types are dots and dashes.  As this example illustrates, the 
first (far left) bullet will always be a black, solid dot or circle.

– And the next indented bullet will always be a black dash. 

• The space between bullet and text should be 1/4”.  Go to “View” pull-down, 
select “Ruler” to display and adjust the spacing between the bullet and text 
(you must be in the text box mode to see the ruler settings).  Do not use 
blank spaces (space bar) to create spacing.

• For ease of use and conformance, the TRAC master template incorporates 
the above guidance as default settings for font, spacing, and bullets.
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Headers & Footers

• The header is the text box above the horizontal, 9.5” long, 2.5 pt 
black line at the top of the slide, while the footer consists of several 
text boxes at the bottom.

• Use the left side footer to display the date that the single slide or the 
whole file of slides was last modified.  Always use the “Fixed” date 
option on both the “Slide” and the “Notes and Handouts.”  Use the 
right side footer to display the number of each slide (except the first 
slide or title slide which is slide #1). 

– To enter or change the information in the footer, go to “View” 
pull-down, select “Header and Footer.”  Checkmark the boxes for 
“Date and time, Fixed,” “Slide number,” “Footer,” and “Don’t 
show on title slide.”   

• If desired, a title may be added next to the page number (currently 
titled, “Ver 1.0, PowerPoint for Analysts” at bottom right on this 
template).   The title is entered into the footer in a similar manner as 
described above using the footer text box provided.  If you do not 
intend to use a title, then delete the current wording from the footer.

• Text in the footers will be gray (vice black) 8 pt Arial bold font, 
enabling it to be visible for reference without being intrusive.



23 July 2003 9Ver 1.0, PowerPoint for Analysts

Ruler Settings

• Proficient use of “Line Spacing” features enables 
the same amount of content to be packaged into 
about the same space while improving its overall 
appearance and readability (as in this example).  

– Use the “Promote/Demote” arrows           on the 
toolbar to manage indentation of any 
subparagraphs (as used for this paragraph).

– Do not permit text to left justify forward of the 
first letter of the first line of a bullet (see ruler 
example at left, instructions on using the ruler 
are on previous slide titled “Text”).

Line & Paragraph Spacing

• The appearance and readability of text can be 

improved by controlling line spacing to increase 

the line separation after the last text line of one 

bullet and before the text line of the next bullet. 

• Go to “Format” pull-down, select “Line Spacing” 

set “Line Spacing” to 0.9 (not 1 or greater).

• Use “Before paragraph” and/or “After paragraph” 

to add extra line spacing to achieve the desired 

effect.  Do not add spaces by using the return key.

Before

After
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Punctuation

• Use proper capitalization of letters.  Do not routinely 
capitalize each letter of a word or phrase.

– Sentences should only have the first letter of the first word 
capitalized.  

– Titles should have the first letter of each major word capitalized.  

– Bullet text should have the first letter of the first word capitalized.

• Place a period at the end of a short phrase or bulleted text 
(except titles), even if it is not a proper sentence.  A period or 
other punctuation after each item in a list of nouns is not 
necessary.  

• Question marks or exclamation points may be used in place 
of a period, where applicable.

• Quotes should be enclosed in quotation marks and properly 
credited or sourced.  Italics font may be used with quotation 
marks. 
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Graph in a Slide (1 of 3)

• A graph (called a chart by Microsoft) for a slide may be created in 
either Excel or PowerPoint.  

• A graph format will be two-dimensional (x-y axes only, without 
depth) unless there is a third axis of information to convey.  Do not 
use a three-dimensional graph for two variables of information. 

• Line plots, bar charts, or pie charts are preferred graphical formats.

• Once the graph is on the slide, its location on the slide may be 
changed like any other object.  To change location, go to “Format” 
pull-down, select “Object” and adjust the values in the “Position” 
tab (calculated from the top and left margins); or left click on the 
graph and use the mouse to drag it.

• To adjust the size of the graph, left click on the graph, go to 
“Format” pull-down, select “Object” and in the “Format Object” box 
that appears, select the “Size” tab, invoke “Lock aspect ratio” and 
use either “Size” (inches) or “Scale” (percentages) to adjust the size 
of the graph; or use the mouse cursor arrow to grab a corner of the 
graph and drag shrink or expand its size (this only works if a corner 
is grabbed).



23 July 2003 12Ver 1.0, PowerPoint for Analysts

Creating a Graph for Use in a Slide (2 of 3)

• In Excel:

– Enter data into the spreadsheet.

– Select the data you wish to graph.  

– Go to “Insert” pull-down, select “Chart,” then select “Chart type.”  

• In PowerPoint:

– Go to “Insert” pull-down, select “Chart,” then enter (edit) the data.

– First row is the x-axis labeling; first column is the legend entry.

– To edit the data of the chart, double-click the chart, go to “View” 
pull-down, select “Datasheet.”  

• For both Excel and PowerPoint:

– To change the “Chart Type” or “Chart Options,” click the chart and 
go to “Chart” pull-down.  

– To change attributes of the graph, right-click on the portion of the 
graph to be changed (e.g., axis, label, legend, symbols, etc.).  You 
may then change object size, font, color, style, etc.  
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Embedding a Graph Within a Slide (3 of 3)

• To embed a graph created with Excel, copy it (it will be automatically 
held in your clipboard) and switch to PowerPoint and use one of the 
options described below.

• For internal TRAC document with a hyperlinked spreadsheet:
– Go to “Edit” pull-down, select “Paste Special” then “Paste link.”  

– If you relocate either the Excel or PowerPoint file within your system, the 
hyperlink may be broken.  The link will be severed outside your system.

– You may edit the linked graph by editing the data within the original 
Excel file, accessible from PowerPoint.

– Others on your system who open the PowerPoint file may be able to 
access your Excel file as well.

• For internal TRAC document with an embedded spreadsheet:
– Go to “Edit” pull-down, select “Paste.”

– Your Excel file will be embedded in and travel with the PowerPoint file.

– Others who open the PowerPoint file can access the original Excel file.

– Double click the graph to edit Excel data.

• For documents to be distributed outside of TRAC:
– Go to “Edit” pull-down, select “Paste Special, Picture” (not “Picture, 

Enhanced Metafile”) to embed the graph.

– Ungroup to edit or rearrange titles, legends, etc.

– Only a picture of the graph is embedded, data cannot be accessed.
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Creating a Slide for a Word Document (1 of 2)

• Use either the TRAC master slide format or a “Blank 
Presentation” format to create your new slide, depending 
upon what you want to paste into the Word document.

• Use the PowerPoint default page size of 10” by 7.5” and a 
minimum text of 18 pt bold to create the slide.   

• When pasted into the Word document, the original slide will 
be smaller.  A text of 18 pt in PowerPoint will appear about the 
same size as 12 pt if you size your figure to be 6.5” wide and 
about 10 pt if you size it to be 5.5” wide.  

• Place all slides for your Word document in a single 
PowerPoint file for ease of maintenance.  Changes to a slide 
should be done in the PowerPoint file and the edited slide re-
inserted in the Word document.

• Retain the PowerPoint file with the final Word document for 
archival purposes.  Document its “Properties” (refer to a later 
slide in this briefing about File Management). 
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Inserting a Slide in Word Document (2 of 2)

• After creating the slide in PowerPoint, go to “View” pull-down and select 
“Slide Sorter.”  Then select the slide you want, go to “Edit” pull-down and 
copy it (it will be automatically held in your clipboard).

• Then switch to the Word document: 

– Place the cursor where you want the figure.  

– Go to “Edit” pull-down, select “Paste Special” then “Picture.”  (This 
takes up the least file size, displays quickest, and does not embed data.)  

– To change its size, go to “Format” pull-down, select “Picture” and in the
“Format Picture” box, select “Size” tab to edit.

Suggested
settings

– To set or edit where and how the figure appears on 
the document page, go to “Format” pull-down, select 
“Picture” and “Layout” tab.   Select “Advanced” tab:  

– The “Picture Position” tab 
enables you to anchor the picture 
to the page or a paragraph and 
lock it in that position.

– The “Text Wrapping” tab enables 
you to select how the text wraps 
around the picture and to set the 
distance between text and 
picture.
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Object Conversion
(To Reduce File Size of Your Presentation)

• Objects (e.g., pictures, photos, images, etc., other than “PowerPoint 
objects”) embedded into a briefing slide file may excessively increase the 
size of your file.  Conversion of these objects can reduce file size.

• Use paste or insert to embed the object into the briefing slide.

• To convert the object (to reduce its file size), select the object and copy it (it 
will be automatically held in your clipboard).  Go to “Edit” pull-down, select 
“Paste Special” and if available select “Picture (JPEG)” (if not available, 
then select “Picture”).  If the original object has “empty” visual space 
meant to be “transparent,” then select “Picture (GIF)” or “Picture (PNG)” 
under “Paste Special.”  The converted object will usually display in the 
same size as the original one.

– If the quality of the displayed object is acceptable, delete the original 
object and reposition the new one. 

– If quality is unacceptable, try other “Paste Special” formats.  

• To adjust the displayed size of the object, right-click on it and then using 
the “Format” pull-down, select “Picture.”  On the “Format Picture” box, 
select the “Size” tab, invoke “Lock aspect ratio” and use either “Size” 
(inches) or “Scale” (percentages) to adjust its size; or use the mouse cursor 
arrow to grab a corner and drag shrink or expand its size.
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Scripted Brief

• There are two options to create a scripted brief. 

• For a “notes page” format (bound at left margin):

– Put script on the notes pages; minimum 18 pt font, bold.

– To print the file, go to “File” pull-down, select “Print” 
and in the “Print what” pull-down, select “Notes Pages.”  
When printing this way, the “slide image” will display as 
4.9x6.5” and 18 pt will display as 12 pt in hard copy, with 
a 1” margin on printed notes pages.

• For a “facing page” format (bound horizontally): 

– Insert a new slide for script and format it by using the 
“Format” pull-down, select “Background,” then check-
mark the box “Omit background graphics from master.” 
Then select “Apply” (not “Apply to all”).   

– Since this will also delete the page number, reinsert it  
on the script page by creating a text box on the page 
and go to “Insert” pull-down, and select “Slide Number.”

– Go to “View” pull-down, select “Slide Sorter” and create 
duplicates of the slide you formatted for script and drag 
a script page to fit between each of the slide pages. 

– For hard copy scripted briefs (that are not projected), 
use a minimum 12 pt font for the text script.  
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File Management

• Accurately document each file you create or modify.  Go to “File” pull-
down, select “Properties” then “Summary.”  As a minimum, fill in the 
information for “Title,” “Author” and “Company.”  Company should be 
identified as “U.S. Army TRADOC Analysis Center (TRAC).”

• Always review “File, Properties” to ensure the information contained in the 
“Summary” accurately documents the file.  It must be edited and updated 
when a new file is created from an existing file.  To be reminded to edit the 
properties when you use “Save As,” go to the “Tools” pull-down select 
“Options” and on the “Save” tab, select “Prompt for file properties.”

• When officially distributing an electronic briefing file, protect its integrity by 
converting the file to a locked “pdf” format using Adobe Acrobat to prevent 
unauthorized changes to it.  This will also facilitate its uniform printing.

• Adobe Acrobat is required (Acrobat Reader is 
insufficient) to convert the PowerPoint file.  Go 
to “File” pull-down, select “Print” and under 
“Printer Name,” select “PDF Writer.” 

• To lock the “pdf” file, open it in Adobe Acrobat.   
Go to “File” pull-down, select “Document 
Security.”  Create a password and restrict 
changing and copying (see example at right).  
Be sure to permit printing.  Save your password.
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Army Green Sand Joint Purple

Colors & Reference Palette

• Black is the standard default color for all text, bullets, lines, box borders, 
arrows, etc.  Use other colors conservatively.  Avoid heavy use of bold, 
bright colors.  Use bright green, yellow, and red sparingly.

• Color choices are available for “Fill,” “Lines,” and “Font.”  The most 
common methods to change colors rely on the “Format” pull-down or the 
icons on the “Draw” toolbar (                  ).   Use “More…Colors, Standard or 
Custom” to select colors.  Under “Custom,” precise values may be 
specified for hue, saturation, and luminosity (see below for examples).  

• The “Format Painter” option (invoked by the paintbrush icon in the toolbar) 
may be used to copy or transfer a color from one object to another.  Click 
on a like item with the desired characteristics, click on the paintbrush icon 
and then on the item to be recolored.  (Caution:  other settings such as font 
size may transfer from one object to another along with the color.) 

• The palette below identifies several preferred colors for reference.

Hue: 35

Sat: 150

Lum: 200

Hue: 35

Sat: 150

Lum: 225

Hue: 70

Sat: 70

Lum: 150

Hue: 70

Sat: 70

Lum: 210

Hue: 195

Sat: 255

Lum: 125

Hue: 195

Sat: 255

Lum: 210
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TRAC Director’s Reminder Guidelines

• Always ensure the content of file properties is accurate and up to date. 

• Use black as the default color for text font, bullets, lines, box borders, 
arrows, etc.  Do not use shadows on text. 

• Be consistent throughout the briefing from slide-to-slide in the use of 
colors, labels, terminology, sequencing, and positioning of content. 

• Use colors sparingly and only for special purposes, e.g., to emphasize, to 
contrast, to draw attention, or to guide the flow of content on the slide.  
Avoid the boldest, brightest colors.

• As a rule, use green to convey “good,” red “bad,” and yellow “caution.”

• On a slide, a positive trend should move from left to right and low to high, 
i.e., from lower left to upper right.

• Do not use cartoon art, clip art, sound, etc., in a professional briefing.  Be 
conservative in the use of PowerPoint animation, to include slide-to-slide 
transition.

• Avoid the use of double or triple line spacing to separate lines of text.  
Instead, become proficient in the use of “Line Spacing” functions 
(“Before/After paragraph”) under the “Format” pull-down.

• Always invoke “Lock aspect ratio” before changing the size of an original 
image, figure, picture, graph, etc.  Otherwise, it may become distorted.


